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Overview of ‘PIC18F/16F Mini Development Board’
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PICI8F/16F mini Development Board:

The Mini Development Kit is designed for learning and experimenting with PIC16F and PIC18F microcontrollers. It
provides on-board programming support, power supply options, input/output interfaces, and expansion connectors,
enabling users to easily develop, program, and test embedded applications. Most labels on the kit are self-explanatory;
descriptions of selected labels are given below. For detailed understanding, refer to the brief introduction to
PIC18F452 and the kit schematic provided in the following pages..

On-Board Features

1. PIC Kit 3 Programming Connector: This connector is used to interface the kit with a PICkit3/3.5 programmer
for programming the MCU. The RST (Reset) pin of the kit is connected to the programmer’s reset pin and is
indicated by a notch symbol.

2.PICI16F/18F MCU: The kit supports multiple 40-pin DIP PIC microcontrollers, such as PIC16F887/887A and
PIC18F4550/4580/4520, as well as other pin-compatible PIC16F and PIC18F devices.

3.USB-C +5 V Power Connector: The kit can be powered using a USB-C cable connected to any +5 V USB power
adapter or USB port.

4.Reset Switch: This switch resets the MCU and restarts program execution. The reset button should be pressed
after downloading a new program to the microcontroller.

AMOTECH Embedded/IoT Development | Automation Services | Training & Counselling
LABS Embedded Development Boards/Kits [PLC & Automation Training Stations

™M

@b“_E www.amotechlabs.com ) +91-8329537565 amotechlabs@gmail.com ‘ \




AMOTECH LABS
Sharing Enthusiasm for Embedded Systems & Automation.

5.Analog Input Slot: This slot can be used to connect devices such as an LM35 temperature sensor or a 10 kQ
potentiometer to provide a variable analog voltage input to analog channel A3.
6.MCU Ports: The port pins of Ports A, B, C, D, and E of the PIC MCU are accessible through these connectors.
Each pin is provided with right-side pin access and left-side labeling corresponding to UDB connectors.
7.UDB Connector: These connectors are used to attach the kit to the Universal Development Board (UDB) of
Amotech Labs. Details of the UDB are available on the official website.
8. Digital Output LED on Pin RC2: Pin RC2, which functions as a PWM-capable pin on most PIC16F/18F MCUs,
is connected to an on-board LED to allow testing and observation of digital or PWM output signals.
11. Two Digital Input Buttons: Two digital input push buttons are provided and connected to RD3 and RD2 pins of
the MCU for user input.
12. Jumper Sets JPI to JP4: These jumpers are used to route SPI and I?C signals of different PIC16F/18F MCUs to
the corresponding SPI and IC pins of the UDB, allocated from D10 to D15.

AMOTECH Embedded/IoT Development | Automation Services | Training & Counselling
LABS Embedded Development Boards/Kits [PLC & Automation Training Stations ‘ 4 \

™M

m’;‘_E www.amotechlabs.com ) +91-8329537565 amotechlabs@gmail.com



amotechlabs@gmail.com

‘g www.amotechlabs.com B +91-8329537565

-~

AMOTECH LABS

PIC18F /16F Mini Development Board Schematic
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Overview of ‘PIC18F/16F Development Board’ Kit:
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PICIS8F/16F Development Board (Enhanced):

The kit used in this laboratory is similar to the PIC18F/16F Mini Development Board and includes additional on-
board features such as a 4x4 keypad, two seven-segment displays, a 16-pin DIP IC socket, and breadboard-style
expansion connectors for interfacing external components.

On-Board Features
3.USB-C +5 V Power Connector with Voltage Selector Jumper: The board can be powered using a USB-C +5

V supply from any standard USB adapter. A voltage selector jumper allows the MCU operational voltage Vdd
to be selected as 5 V or 3.3 V as per the jumper placement.

11.4%x4 Keypad: An on-board 4x4 matrix keypad is provided for user input. The keypad is directly interfaced to
Port B of the PIC microcontroller as per the schematic.

12.Seven Segment Displays: Two common cathode seven-segment displays (SSD1 and SSD2) are connected to
Port B for segment data. The common cathodes are controlled using RD2 and RD3, enabling multiplexed two-
digit display.

13.16-Pin DIP IC Socket: A 16-pin DIP IC socket is available to interface 8-pin or 16-pin ICs such as L293D,
ULN2003/2004, or op-amps. All IC pins are accessible for connection to the PIC MCU.
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‘PIC18F/16F Mini Development Board’ can be mounted on below UDB Kit:
Universal Development Board(UDB) kit

One Development for

Studying Embedded Systems | Project Development | Product Prototyping
on below multiple 8 & 32-Bit Microcontrollers
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‘PIC18F/16F Mini Development Board’ mounted on UDB Kit’s Slot 1 can be seen in the
below UDB Kit which has DC, Servo and Stepper Motors mounted on-board.

AMOTECH LABSE
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Note:This Kit was assembled for College Lab use in Wooden Box Enclosure. That’s why it is fitted on a Acrylic
Sheet with Motors mounted on it for studying their interfacing using PICISF MCU & UDB. For Students, only
UDB is also available to buy with ‘UDB 2 Wheel Robot Acrylic Sheet’. Students can configurethe UDB by
adding the peripherals as per their application needs.

[ 8051 Shield | P¥C18F/16F
; u (by Amolech Labs) ' (by Amolach Lal
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Introduction to PIC18F452 Microcontroller
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RAT/AN] =—=[]3 18 || =—= RBS/PGM
RA2IAN2IVREF- «—[]4 37 [] «=— RB4
RAIANINREF+ == 15 16 [] =—» RB3ICCP2*
RA4TOCK «— []6 15 [] «—e RB2/INT2
RASIAN4/SSILVDIN =—=[]7 % 14 [] «— RB1/INT]
REO/RD/ANS =—= ]38 i 13 [] «—= RBO/INTO
RE1/WRIANG =—=[]0 h 320 =— Voo
RE2/CSIANT =] 10 0 M) =—Vss
Voo —= (11§ 30 [] =—= RD7/PSFT
| p— R 29 [] =—= RDGIPSFS
0SCA/CLK ——«]13 28] =—» RD5/PSPS
0SC2ICLKORAS =— ] 14 27 ] =— RD4/PSP4
RCOM10SOMICK «—w (] 15 96 ] =— RCT/RXDT
RC1M10SICCPZ* «—» (116 75 ] «—= RCBTXICK
RC2ICCP =[] 17 74 [] «— RC5/SDO
RCI/SCKSCL == 118 23] =« RC4/SDISDA
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Features of PIC181452:
V' Operating Frequency : DC - 40 Mhz
V Program Memory (Bytes): 32K
V' Program Memory (Instructions) : 16384
V Data Memory (Bytes): 1536
V' Data EEPROM Memory (Bytes) : 256
v Interrupt Sources 18 1/0 Ports : Ports A, B, C, D, E
V' Timers : 4
V' Capture/Compare/PWM Modules : 2
V' Enhanced Capture/ Compare/PWM Modules : 2
V' Serial Communications : MSSP, Addressable USART
V' Universal Serial Bus (USB) Module : No
Streaming Parallel Port (SPP) : Yes
10-Bit Analog-to-Digital Module : 8 Input Channels
Comparators : 2
v Programmable Low-Voltage Detect : Yes
V' Instruction Set : 75 Instructions; 75 Instructions

V' Packages : 40-pin DIP, 44-pin PLCC , 44-pin TQFP
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MPLAB X IDE For Downloading Program PIC18F/16F MCU’s
Downloading and installing MPLAB X IDE, XC8 Compiler & MPLAB IPE

Refer: https://youtube.com/@amotechlabs?si=KrWOtqwmzJxJFm6P

Below are the steps to program any PIC18F/16F MCU in MPLAB X IDE.
1. Double click on MPLAB X IDE icon on the desktop & Open MPLAB X IDE.

2. To create new project. Select File -> New Project.

® import Legacy

Haw

# Import Prabuitt

& T ot

Recent Projects

B4 MPLAB X IDE v3.45 - default : default
File Edit View Mavigate Source Refactor Run Debug Team Tools Window Helj

ﬁ\ MICROCHIP

Microchip Login

* Errata
® Froduct Selection To.

LEARN & DISCOVER | MY MPLAB® X IDE | WHAT'S NEW

EI Mew Project...
| 9 New File...

Open Project...
| Open Recent Project

AMOTECH
LABS

Exit

Import

Close Project

Close Other Projects

Close All Projects
Open File...
Open Recent File

Project Groups...
Project Properties

Save
Save As...

Sawve All

Page Setup...
Print...
Print to HTML...

Ctrl+Shift+M

I:g‘CtrHN

Ctrl+ Shift+ O

Ctri+5

Ctrl+5hift+5

Ctrl+ Alt+Shift+ P

fﬁ.t.-art. I;.-age x |

i

PROJECTS

Open Sample
Create New
Import Legacy
Import Prebuilt
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3. After that below window will appear. Select Microchip Embedded ->Standalone Project & Click next.

B4 Mew Project >
Steps Choose Project
1. Choose Project Q, Filter:
T el
Categories: Projects:
15 Microchip Embedded ﬁw
. ..... |53 Other Embedded ﬁ Existing MPLAE IDE w8 Project
[EI Samples {d Prebuilt (Hex, Loadable Image) Project

[l User Makefile Project
ﬁ Library Project

Description:

Creates a new standalone application praject. It uses an IDE-generated makefile to build your
project.

< Back _ Fimish- | | Cancel : | Help

4. Select Family >Advanced 8-bit MCUs(PIC18) then select Device>PIC18F452 or any other MCU.
In Tool you can select No Tool.

B4 New Project X

Choose Praject
Family:

Select Device
Select Header
Select Plugin Board
ﬁ Praject Name and Devige: TC18F452 w
Folder

fOational) Add Broject Tool: No Tool

All Families -

LR

=

W DS”WWM

X IDE
-

< Back Add Another Project Finish Cancel Help
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5. Now select the previously installed latest version of XC8 compiler and then click Next.

& |

: 5 (v1.00) [C:\Program Fies (x86)Microchip e\ 1.00\oin]
Select Compiler i~C18

- HI-TECH PICC18-PRO
Folder ' HI-TECH PICC18-5TD

[ <Back |[ Mext> ][ Frish |[ cancel |[ Hep |

6. E nter your Project name > Click on Browse and Choose Project Folder location > Click on Finish.

EJ Mew Project b4

J i 4 Select Project Hame and Folder

i |
§

Select Device Project Name: LED_Blinking
| CelectPh : i Project Location: Cr\Usersi\User MPLABYProjects Browse...

'_ Sﬂmhm and Project Folder: CriUsers\User WPLABNProjects\LED _Blinking. X

Croerverite edsting praject
Alzo celate searces,
] Set as main project

Dmmbmhmuh%oﬂ(tmr

Encoding: 150-8859-1 e

<Back Hext > Cancel Help
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7. Now our project is displayed in Project window.

Projects = =
=N=RI ED_Blinking

[ Header Files
ﬁ' Important Files
-- Linker Files
-- Source Files
ﬁ' Libraries
ﬁ' Loadables

8. Create the Main file for developing code. Right Click on Source file in the project -> Select new ->
Select main.c File.

Projects x ] =] Start Page = @ Configurati
Elﬁ LED_Blinking Sgurce  History | -
E-[gF) Header Files - _ :
b I#| configurations_Header_File.h :| a :'_';::‘::'F'_p_
([ Important Files o | BN
G-[F Linker Files 2 " - i
B[S Lbraries MNew » [0 Directory..
ﬁ' Loadable Mew Logical Folder 2] main.c.. I}-
Add Existing Item... ] xc8_header.h...
Add Existing ltems from Folders... pic_8b_asm_func.asm...
Find... [ TextFile. !
Cut Other...
Copy 13| i
Paste Ctrl+y 14 * F
15 [ nd
Remowve From Project 16| -
Rename... 17 -
1z *
LED Blinking - Dat Properties 19 *
f T - =l =nl L |«
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9. Give name to C file and click on finish.

B3 Hew main.c x
Steps: Hame and Location
L Choose File Type File Name: |bhnk__of led
2. Mame and Location —_—
Extension: |c "
Set this Extension as Default

Folder: |  Browse...

Created Fie: |C:\users\User \MPLABKProjects\LED_Blinking. X\bink__of led.c

<Back | [Hexts | [ Fsh | [ cance | [THER

10. Write your program.
1 1. Afer you complete your program then Build it by clicking on a Hammer as seen below.

'm MPLAE X IDE w3.45 - LED_Blinking : default
File Edit View Mavigate Source Refactor Run Debug Team Tools Window Help

PGS D@ AT P-L-2-QB-

12. Afer building a Project, output Window appears which gives errors and warnings if any.
otherwise Build Successful message appears as seen below.

[ outsut - LED_Blinking (Build, Load) x|

i
Hamory Sussary:
Prageas Space uEad 64k 100} &f 8000k Byras { 0.3%)
Data space wsad [ &) =f B0k bByses i @.3%
Condigurasion bits used Tho( 7 of Th wozds (100,00
EEFROM space usead o ¢ 0} of 100k bycas { 0.0%) I
ID Location apace waad ER B} eof Eh bBycaa {L100.0%)
Dats szack space wand ok 0) &f TAOR bytes i 0.0%)

¥ou have compiled in FREE =ode.

Using O=micient Code Cemsratics that is svailable in PRO =sde,

you could have pooduced up to 60% smaller and 400V faster code.
See http:// v microchip. com/HFLABNCcompilers for more information.

=ake[2]: Leaving dizectery 'C:/Users/Uses/MILAEKPzejects/LED Blinking X'
=akelll: Leaving dizectosry 'Ci/Usezs/Tees HPLABNPzojects/LED Blinking X'

EUILD SUCCESSESUL itotal cime: 42}
Lasding code from C:/Users/User/MULABKDProjasss/LED Blinking X/disc/dsfaule/produceisn/LED Blinking X.produscion hax. .
Loading completed

12. After BUILD SUCCESSFUL, Hex file is created in the project folder. In project folder Hex file is
created in dist/default/production. You can also see a path to the folder under BUILD SUCCESSFUL.
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MPLAB IPE for Downloading Program in PIC18F/16F MCU’s

Below are the steps to program anyPIC18F/16F MCU in MPLABX IDE.

1.0pen MPLAB IPE software. Select the Family and Device name of the MCU you want to program. Connect
the USB of PICKit 3/3.5 Programmer to your PC, after connecting it the programmer name will appear in the
tool. Now connect 12V power supply adapter to PIC18F/16F Kit and PICKit 3's 6 Pin connector to your
PIC18F/16 kit directly as seen in the Kit Overview Pic on Page 3. Also, you can connect it using 6-pin F-F
connector wires. PICKit 3's first pin indicated with arrow should be connected to RST pin of your PIC18F/16F
kits 6-pin connector. Now, click on ‘Apply’ and then on ‘Connect’.

ICSP Conn & PICkit 3 Programmer. ..

& Cowsir @
§ Drvcn and Tood Sebechon =
® e Advanced B8 MCUS (PICTE) - EPON Chmcimem.. [R5
Chichen: | Q3ED
Took PCRED 5 e | BURTE 106730 = ko The
Tolsl Cowniz | 133
1 Haen File: ek rmama e nileal = ha i —
Reset Pin of ICSP Conn. on : i
PIC18F/16F Kit : on brcerne 5 selct 2 ST _
Owtpast - IFL = :

2. Once you click on Connect, below pop-up window may appear if you have not done Programming Power Source
and Voltage level settings. Programming voltage and Power settings should be done before downloading the Program.

= | Opeate 1 slE
g Drevl and Tood SapCtaon RaaRs
. CP=OFF Chachsem: | 3208
Famiy)
Chechwem: | 100 m
Cuvice:
Pans Comnt [5q
|
Ty Fadl Cowni: 38 |
Total Cownt: | 333 |

b CALUMICHE Chanck that tha device selected im MPLAB IPE (PIC LEF43) i the same one
—_ R T —— "
Selectag 8 5V Sece st b 1OV devece 5 CoRRered i el @ AImegE 10
e g it on b e device when the debugger checks the devene I0.
Doy yoma wiith bo comtinue .

(] Bie racrt i e il Il
& | Cael
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3. To confirm if correct Programming Voltage and Power Source is selected, we need to click on Setting and select
Advance Mode. Then below Pop-Up window will appear. Enter the default password ‘microchip’ as given in the
Hint and press Log in. Now you go in Advanced mode.

) MPLAB IPE v6.20 — (m] x
iFlIe View Tools Window Help
" Operate | n|C)E)
fl  Device and Tool Selection Resulls ]
Family: All Families -

Checksum: 8208

Device: PIC18F452 - | s Pass Count: ’2ll1—|

B Advanced Mode oo
Fail Count: 44
Tock: Select Tool | Log on to advanced mode = ,
otal Count:  [245 ]
Password:

I Hint: Default password is microchip I

k] Change Fassword Login 1
— — - — —— —
1 Resel Password Forgot Password :
Hex Fibe: Click on browse to select a Keep me logged in Br =

SQTP File: Click on browse to select a SQTP file

] — -

:_Dul:put-rﬁ x| =1

4. Once you are in Advance Mode, you will see the ‘Options’ tab on the left. Click on it and select ‘Power’ tab, then
below window will appear. Un tick the below check box and select the Voltage level as 5.0 Volt. Now, must be
powered by external Power Supply before downloading the program.

5] MPLAB IPE v6.20
File Settings View Tools Window Help

| Operate | PowerSettings x

Power Settings

@ Options [h

Voltage options

Power target circuit from PICkit3 D

Voltage Level 5.0 -

Program Options

Use low voltage programming ...

Reset to defaults

LABS Embedded Development Boards/Kits [PLC & Automation Training Stations
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5. Once Voltage and Power Source is selected, click on ‘Operate’ tab. Now, select you Hex file by by clicking o

n ‘Browse’ and navigate to your Hex file location. In your Projet Folder you need to navigate to
dist>default>production and select your Hex File.

Yo

m Power Settngs. ® i (=)
&- and Tool Selecton Rty

[=] ' - — CR=OFF Chachsum: | 308
Checksun: | 8208 [12]
VST [ p—— = - >
Towodz
< I T S0 % gt 3 defeult » pedduction . . -
Cugarize ~ Hew folder E- 0 @
1 Factures ¢ Harre Diate meodidoed Tope
" Lift Cyfinder * U] ADC_LCD mternee  production e
Hex Fi G Mt o
Wedeos #
SaTP| u
— =1 All Progeam pdf in T
Dutp
1 peoducton
il -
el producticn
T Hew Programs
wei
Im
E | File s « | HEX Filg (" HEX" hex)
Open Cancel
=
— —

6. Once you select the Hex file you will see the notification Hex File Loaded Successfully in ‘Output IPE’. Click on
‘Program’ button.You will see PICKit 3 LED’s flashing and ‘Programming...” in Output-IPE. And, finally
‘Programming complete’ once downloaded. Now remove PICKit 3 and see your program running on the Kit.

(=R
=
File Sefings View Tock Window ey
= OCoerse | Powerfetrge w i =
g Dirvice amd Tool Sesection Roguly
CP=OFF Checksam: |
L AN Fired E =
Checksum:  4EM ]
Dewice: PICISF452
Pass Count: [ yo0
Took PICKES 5 Mo - BUR1S1106730 - Disconnect Fall Count: |33
Tobul Count: | F33
&L program 2 e B rese B verry ¥ e crecs
SGTP Filez | Chli on vowse io selecia STP fie [Fe—
Output - TPE = =

Loading cede frem D:\Tiles\MSOTECH  Quotes'Pune Universiny Joshi Haedam\PICIOT4EI_Fregrams_splab_siliew Programs’
APPTIELBATS BEROTY usage: JEA

203 BT S #0430 - Hexm file loaded sutcessfully

2038=92=36 123:07:13 #0430 = Programming

Device Eraded. . .
Programming. . .

The following memcsy azeais) will b+ progrsmed

PECOEAR BemsrY! sLary sddress = Ond, end sddress = Oulili
configuraticn memcEy

Fregrasming rify compleve

F038=93=34 13:07:33 +0430 = Programming complets

P Tiok PR S Mo BURMSTIOGT | Device: PICSIFASG. | Ervrorvmar: b ic s o D6 3.6.150J0o Pack Versenchia
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Lab 1 - LED Blinking

Aim: To study the LED’s Interfacing with PIC18F452 mini development.

"k
]
Tk
Tl
* ok
il
*
» il
'l-.'\_

LED

Note: The same code can be performed on the ‘PICI8F/16F Development Board’, an extended version of this
board that features an on-board 2 seven-segment displays, a 4x4 Keypad, and an additional 16-pin DIP IC slot.

Procedure:

1.Read the LED Blink Program on next page with all the comments which explains the program.

2.0pen the Project folder for the program in MPLAB X IDE or write it by making new project as per
MPLAB X IDE procedure explained in the manual. Build and generate the Hex file for the same.

3.0pen MPLAB IPE and follow the procedure explained to download the Hex file for the above program.

4.Use PICkit3 programmmer to program the PIC microcontroller with the HEX file. 5.Make sure that the
arrow side of the programmer must be connected to the RST pin of the ICSP connector of the board.

AMOTECH Embedded/IoT Development | Automation Services | Training & Counselling
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Program:

#include <xc.h>
#define XTAL FREQ 20000000

0 MHz crystal frequency (for delays)

HOTE ABOUT XTAL FEEQ AND OSCILLATCOR SELECTION

_XTAL FREQ =F:]

so that

The ACTUAL oscillator

Examples for PIC1E2 family MCUs:

1) PIC18F4620 (Internal Oscillator)
#pragma config OSC = INTIOGET Internal RC oscillator
CSCCON = 0xT72; ff B8 MHz internal cl

#define _XTaAT. FREQ 8000000 f Must match inte

[
[}
=
L
[
(5]
!
[f=9
o
[
=1
L]
of
m
H
&
o
I
[y
I
]
ot
f

[

/ External high-speed crystal

Typical dev-board crystal

L
)
[

L]
[

o
L]
19
(]
[

Commonly

10 MHz, or 20 MHz external crystals:

#pragma c

7 as GPIC pins.

1l crystal mo 7 as oscillator pins.
- _XTAL FREQ MOUST always match the actual CPU clock,

otherwise delay functions will be incorrect.

f Configuration bits
#$pragma config OSC = HS /f High-speed external
$pragma config WDT = QOFF /f Disable watchdog timer

OFF /f Disable low—voltag

$pragma config LVP

#$define LED LATCbits.LATCZ /4 LED connected to RCZ2 pin

vold main ()
{
TRISChits.TRISCZ2 = 0; /f Set RC2Z as output

while (1)
{
LED = 0;
_ delay ms(1000});

e low)

LED = 1:
_ delay ms(1000);

return;

NOT select the oscillator source.It only tells the XC2 compile

the CPU clock frequency

= configuration bits (pragma copfig).

AMOTECH
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Lab 2 - LCD Interfacing

AiIm: To study thel6x2 LCD Interfacing with PIC18F452 mini development kit.

_.."
u .
’!;
,M_.
-
ts
! e
¥
Y

10K Pot

IO Dees, Boseo
b HMOTECH LHES

Note: The same code can be performed on the ‘PICI8F/16F Development Board’, an extended version of this
board that features an on-board 2 seven-segment displays, a 4x4 Keypad, and an additional 16-pin DIP IC slot.

Procedure:

1. Read the LCD Interfacing Program on next page with all the comments which explains the program.
2.0pen the Project folder for the program in MPLAB X IDE or write it by making new project as per
MPLAB X IDE procedure explained in the manual. Build and generate the Hex file for the same.

3.0pen MPLAB IPE and follow the procedure explained to download the Hex file for the above program.
4.LCD contrast can be adjusted using 10k pot beside LCD. Once you download the program and remove
the programmer, you will see above contents on the LCD.

5.Make sure that the arrow side of the programmer must be connected to the RST pin of the ICSP connector
of the board.
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#include <xc.h>
#include <picl8f4

-

I

fdefine XTAL FREQ 20000000 /i 2

SOUrcCe 18 3¢

config) .
p=mct et

/f Configuration bits

#pragma config OSC = HS
$pragma config WDT = OFF
frragma config LVP = OFF
fpragma config BOR = OFF

f/ LCD pin connectionsz (4-bit mode)
§define R5 LATDbics.LATDO
§define EN LATDbics.LATD1
#define D4 LATDbits.LATD4
§define DS LATDbits.LATDS
#define DEé LATDbits.LATDE
§define D7 LATDbicts.LATD?

void LCD Init();
void LCD Command (unsigned char);

void LCD char (unsigned char):

void LCD_string(const char®);

void LCD_string xy(char, char , const char*);
woid l.CD_clerar'E);

int main(veoid)
14
ADCON1 = OxOF;
TRISD = Qx00; 'y
LATD = 0x00; £

LCD_Inic(): // Initialize LCD

AMOTECH Embedded/IoT Development | Automation Services | Training & Counselling
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LCD _Inic(): / Initialize LCC

LCD_string xy(1,0,"PIC Dev. Board"):
_ delay_ms(1000);

LCD_Command (0xC0) ; /
LCD scring xy(2,0,"by AMOTECH LAF

while(1l); Stay here
-}

void LCD Init()
11

_ delay ms(40}); LCD power-=up delay

D4=1;
D4=1;
DqmQ)

=1: delay us(5); EH=0:

__delay us(5); ENwO;

LCD Command (0X28) ;
LCD Command (0x0C) ;
LCD Command (0x06) ;
LCD Command (Ox01) ;
_ delay ms(2);

volid LCD Command (unsigned char cmd)

{

RS = 0; Sf Command mode

/f Send upper nibble

D4 = (cmd >> 4) & 1:

DS = {cmd >> 5) & 1;

De = (cmd >> &) & 1:

D7 = {cmd >> T) & 1;

EN = 1; _ delay us(3): EN = Q;

/f Send lower nibble

D4 = cmd & 1:

DS = {cmd >> 1) & 1;

De = (cmd >> 2) & 1:

D7 = {cmd >> 3) & 1;

EN = 1; _ delay us(3): EN = Q;

_ delay us(50): S Command execution delay
}

void LCD char(unsigned char data)
{
RS = 1; // Data mod

i

/f Send upper nibbkle
D4 = (data >> 4) & 1;

D5 = (data >> 5) & 1;
De = (data >> &) & 1:
D7 = (data >> T7) & 1;

EN = 1; _ delay us(5); EN = O;

=1; _ delay us(5); EN=0; _ delay us(150);
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04 = data & 1;

D5 [data >> 1) & 1;
De = (data »>> 2) & 1;
o7 (data >> 3) & 1;

EN = 1y delay us(5): EN = 0O;

_delay us(50); // Character write delay

void LCD string(const char *msg)

{
while (*msg) // Print until null character
{
LCD char (*msg++);
}
}

void LCD string xy(char row,char pos,const char *msg)

{
if(row == 1)
LCD Command (Ox80 + pos); /4 First line
else
LCD Command (0xCO + pos); // Second line
LCD string(msg):
}

void LCD elear()

{
LCD Command (0x01) ; /f Clear LCD
_delay ms(3):
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Lab 3 - ADC Interfacing

Aim:To study the ADC interfacing with PIC18F452 mini development kit.

R

Made In HDIA §iE ]
rRBY To ROT- SV GHD  piC18F /16F Devel

Note: The same code can be performed on the ‘PICI8F/16F Development Board’, an extended version of this
board that features an on-board 2 seven-segment displays, a 4x4 Keypad, and an additional 16-pin DIP IC slot.

Procedure:

1.Read the ADC Interfacing Program on next page with all the comments which explains the program. Open
the Project folder for the program in MPLAB X IDE or write it by making new project as per the MPLAB X
IDE procedure explained in the manual. Build and generate the Hex File for the same.

2.0penMPLABIPEand follow the procedure explained to download the Hex file for the above Program.
3.UsePICkit3programmmer to program the PIC microcontroller with the HEX file.

4 Makesurethatthearrow side of the programmer must be connected to the RST pin of the ICSP connector of
the board.

LABS Embedded Development Boards/Kits [PLC & Automation Training Stations
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Program:

$include <xc.h>
$include <picl8f452.h>
#include <stdio.h>

#include <string.h>

#include <stdlib.h>
$#define _XTAL FEEQ 20000000 f4 20 MHz crystal fregquency
Configuration bitcs

#tpragma config QSC = HS

$pragma config WDT = OFF
$pragma config LVP = OFF
$pragma config BOR = OFF

LCD pins (4-bit mode)

#define RS LATDbits.LATDO
#define EN LATDbits.LATD1
#define D4 LATDbits.LATD4
#define DS LATDbits.LATDS
$define DE LATDbits.LATDE
$define D7 LATDbits.LATD7
void LCD Tnitialize();

vold LCD COMMAND (unsigned char);
void LCD char (unsigned char):

declarations

void LCD string(const char *);

void LCD string xy (char, char,const char *):
void LCD elear():

void ADC initializel();

unsigned int ADC read(unsigned char):

$define wref 5.00 ff BADC referenc

m
[u}
F
it
]
e
o

int main (void) {
char data[l0]:
unsigned int digitald
float woltage;
int k;
char ADC ARRAY[5]:;
TRISD = 0X00; S/ LCD por 33 outpu

III
[u]
it
o]
L]
[u]
it

III
it

nitialize LCD

LCD Imitialize();
ADC inmitialize():;
LCD string x¥(1,0,"voltages i=s..."):

LCD COMMAND (O=CO) ; /f HMove to second line

nitialize ADC

while(1l){
digical = ADC read(3): // Read ADC chann
voltage = digital * (vref / 1023.0);:
for{(k = 0; k <= 3; k++)// Convert ADC -
{
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ALDC RERAY[k] = (digital % 10) + '0O';
digital /= 10:
}
LCD COMMAND (O=CO) ; /{ Second line start
for{k = 3; k >= 0; k--)
{
LCD char (ADC ARRAY[K]):
}

sprintcf (data, "(2f",voltage) ;
strcat (data,"V"):
LCD string xvi(2,&,data);

__delay ms (250} ;

T

DC setup

wvold ADC initialize()

{
TRISL = OXFF; /4 PORTLA as input
RDRESH = 0;
RDERESL = 0;

H

iead ADC wvalue

o]
T

unsigned int ADC read(unsigned char channel)
{
unsigned int digital:

ADCONO = (ADCONO & Obl1000111) | ((channel << 3) & 0bO0O111000);
ADCONObits.ADON = 1;
ADCONCbits.GO nDONE = 1;

while (ADCONObits.GO nDONE): // Wait for conversion
digital = ADRESH;

digital = (digital << &) | ADRESL;
digital >>= &; S/ Blign 10-bit result

return digital;

f LCD initialization

volid LCD Imitialize()

{
LCD COMMAND (Ox02)
LCD COMMAND (Ox28):
LCD COMMAND (OxOC) :
LCD COMMAND (Ox06) :
LCD COMMAND (OxO1) ;
__delay ms(2);
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f Send command to LCD

wvoid LCD COMMAND (unsigned char cmd)

{

RS = 0;

04 = (cmd >> 4) & 1;

DE = {cmd >> 5) & 1;

Dt = (cmd >> &) & 1;

D7 = (cmd >> T7) & 1;

EN = 1; delay ms(5); EN = 0;

04 = cmd & 1;

D5 (cmd => 1) & 1;

D& (cmd => 2} & 1;

D7 (cmd => 3) & 1;

EN = 1; delay ms(5); EN = 0;
}

Send character to LCD
wvoid LCD char(unsigned char data)
{

RS = 1;

04 = [data >> 4) & 1;

DE = [(data >> 5) & 1;

De = [(data »> &) & 1;

D7 = (data »> T7) & 1;

EN = 1; delay us(3); EN = 0;

4 = data & 1;

D5 = [(data »> 1) & 1;

De = [(data >»> 2) & 1;

D7 = [(data »> 3) & 1;

EN = 1; delay us(3); EN = 0;
}

Display string

volid LCD string(const char *msg)
{
while (*m=sg)
LCD char (*msg++);

— T

3= = e e
e A S = L

and display string

|il-

void LCD string xy(char row, char pos, const char *msg)

i
unsigned char location;
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location = (row = 1) ? (0x80 + pos) : [(0=xCO + pos);
LCD COMMAND (location);
LCD string(msg);

R —

/£ Clear LCD

voild LCD clear()

{
LCD COMMAND (0x01);
__delay ms(3);
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Lab 4 - Pulse Counter

Aim: To study the Pulse counter program with PIC18F451 mini board.

T

[ ECOU ULy & w

4

LA .

|

“§

. 4
.

FAO. 84
Sl @

Note: The same code can be performed on the ‘PIC18F/16F Development Board’, an extended version of this
board that features an on-board 2 seven-segment displays, a 4x4 Keypad, and an additional 16-pin DIP IC slot.

Procedure:

1.Read the pulse counter Program on next page with all the comments which explains the program.
2.0pen the Project folder for the program in MPLAB X IDE or write it by making new project as per MPLAB X
IDE procedure explained in the manual. Build and generate the Hex file for the same.

3.0pen MPLAB IPE and follow the procedure explained to download the Hex file for the above program.
4.Make the connections as above shown in figure.
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Program:

#include <=c.h>
$define
$include <picl8f452.h>
#include <string.h>
#include <stdio.h>

$pragma config OSC = HS

$pragma config WDT = OFF
$pragma config LVPF = OFF
$pragma config BOR = OFF

#define
#define
#define
$define
tdefine
#define

wvoid
wvoid
wolid
woid

void led clear (void): Iy

vold led setcursor (unsigned char row, unsigned char column);
vold setop()

wiold displayconnt (unsigned int count);

volatile unsigned int pulseCount

_XTRL FREQ 20000000

connections
LATDbits.
LATDbits.
LATDbits.
LATDbits.
LATDbits.
LATDbits.

LCD pin
RS
EN
D4
DS
DE
D7

([4-bit mode)
LATDO

LATD1

LATD4

LATDS

LATDE

LATDT

Function declarations

led init(void); I
lod command (unsigned char cmd)://
lecd char (unsigned char data):

led string(const char *str):

volid setup()

{

¥

L T T o B

data kit D4
data kit DS
data bit Db
data kit D7

LCD displav

lear

ADCONL = 0Ox0QF; f/ All pins digital
TRISD = Ox00; [/ LCD port output
ff Timezrl (SW1l on RCO)
IRISCbits.TRISCO = 1: R =T nput
T1CON = Ox87; r, Timerl O
THMR1H = O;
THRL1L = (;
Timexr0 (SW2 on RA4)
TRISAbics.TRISA4 = 1; f/ RA4 = TOCKI inpur
TOCON = OxA9: f/ Counter mode, external clock, Timer0
THMROH = Q;

THROL =

0;

led_init():

viold main()

{

AMOTECH

setup () ;
led clear():
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while (1) S Infinite loop
{

Eead l6-bit Timerl wvalue

unsigned int tlPulseCount = (THE1H << 8) | THE1L:

Eead le-bit Timer0 wvalue

unsigned int tOPulseCount = (THMEOH << 8) | THELL;
char tObuffer[lé], tlbuffer[le6]l; // Buffers for LCD text

Format Timerl count for LCD

sprintf(tlbuffer,"SW1l Count:%u",tlPulseCount) ;

Format limerl count or LCD

sprintcf (c0buffer, "5SW2 Count:%u",t0PulseCount) ;

led setcursor(l,l);
lcd string(tlbuffer):

lcd setcursor(2,1): /f Mowve cursor to row 2, column 1
led string(tlbuffer): S f Display Timer count
__delay ms(30); /{ Refresh delay
}
}
Display a single count value (not used in main)

vold displaycount (unsigned int count)
{
char buffer[le];
lcd clear(): Iy
sprintf (buffer, "Count: %u",count):;
led string(buffer):

S Inmitialize LCD in 4-bit mode
void led init(void)

{

lod command (0x02) 7

lod command (0x28);

lod command (0x0C) ;

lod command (0x08) ;

lod command (0x01);

__delay ms=s(2):

/f Send command to LCD
void led command (unsigned char cmd)
{

R5 = 0;

AMOTECH Embedded/IoT Development | Automation Services | Training & Counselling
Embedded Development Boards/Kits |PLC & Automation Training Stations

LABS s ™M

'ﬁsb www.amotechlabs.com ) +91-8329537565

— amotechlabs@gmail.com



AMOTECH LABS

Sharing Enthusiasm for Embedded Systems & Automation.

D4

DS =

D&
D7
EN

D4

DS =

D&
D7
EN

S5end one character

Send upper nibble
= (cmd>>4)&0=x01;
{cmd>>5) &0x01;
{cmd>>6) &0x01;
{cmd>>T) &0x01;

1l; delay ms(5):; EN =

Send lower nikbble
= cmd & O=x01;
{cmd>>1) &0x01;
{cmd>>2) &0x01;
{cmd>>3) £0x01;

= 1; delay ms(3):; EN =

vold led char(unsigned char data)

{

void lcd_zatcursatﬁunsiqn&d char row,

{

void led string(const char

{

RS

/S Upper
D4 =

DS
D&
D7
EN

s =

De

N

=1:

nikbble

(data>>4) &0x01;
(data>>»5) &0x01;
(data>>6) &0x01;
(data>>T) &0x01;

data & Ox01;

(data>>1) &0x01;

= (data>>2)&0x01;

= (data>>3)&0x01;

= 1- _de'_a}'_'_'S[El}; EN = 07

= rEaT Bosicior

unsigned char position;

if(row == 1)

posicion = Ox80 + column - 1}

elgse if (row == 2)

position = O0xCO 4+ column - 1;

lod _command (position) ;

*atr)

while (*scr)

{

lcd char (*str++):

vold lod clear (vold)

i

locd command (0x01) ;

_ delay ms(2);

_ delay us(50);

0; _ delay ms(50):

0;  delay ms(50):

1; delay us(5); EN = 0; _ delay us(50):

unsigned char column)

Embedded/IoT Development | Automation Services | Training & Counselling

AMOTECH

™M

LABS Embedded Development Boards/Kits [PLC & Automation Training Stations

'ﬁsb www.amotechlabs.com ) +91-8329537565

amotechlabs@gmail.com

33



AMOTECH LABS
Sharing Enthusiasm for Embedded Systems & Automation.

Lab 5 - PWM

Aim: To study the PWM with PIC18F452 mini development kit

Note: The same code can be performed on the ‘PIC18F/16F Development Board’, an extended version of this
board that features an on-board 2 seven-segment displays, a 4x4 Keypad, and an additional 16-pin DIP IC slot.

Procedure:

1.Read the PWM Program on next page with all the comments which explains the program.

2.0pen the Project folder for the program in MPLAB X IDE or write it by making new project as per MPLAB X IDE
procedure explained in the manual. Build and generate the Hex file for the same.

3.0pen MPLAB IPE and follow the procedure explained to download the Hex file for the above program.

4.As you vary the PWM signals fed to pin RC2, you will see brightness of LED connected to RC2 changes.

5.Make sure that the arrow side of the programmer must be connected to the RST pin of the ICSP connector of the board.
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Program:

$include <=c.h>

$tinclude <picl8f4s52.h>

#include <string.h>

#pragma OSC = HS

tpragma WDT = OFF
$pragma LVE = OFF
#pragma BOR = OFF

$define _XTAL FREQ 20000000 Jf Define system cl«
vold main()
{

unsigned int duty cycle;

TRISCbits.TRISCZ = 0;

FRZ = 124;

CCPR1L = 1; S/ Imitial PWM duty cvcl

m
i
M
;
1]
=]
]
=
.
[=)
=
ot
e
=]
m

T2COHN = 0X04%;

CCRLICON = 0X0C: ff Configure CCPl module in PWM mode
THMRZ = 0O; f{ Clear Timer2 register
T2CONbits . THEZON = 1; S/ Turn ON Timer2 (starts PWM generation)

while (1) S/ Imfinite loo

{
/f Gradually increase duty cycle (ramp up)
for(duty cycle = 1; duty cycle < 124; duty cycle+t)
{

CCPR1L = duty cycle: // Update FWM duty cy

__delay m=(20): S/ Small delay to make change wvisibkle
¥
__delay m=(500}); S/ Hold at maximum speed for a while
f Gradually decrease duty cycle (ramp down)

for(duty cycle = 124; duty cycle > 1; duty cycle--)
{
CCPR1L = duty_cycle; [/ Update PWM duty cycle

__delay ms(20); Sf Small delay to make change visible
H
__delay ms(500); S Hold at minimum speed for a while
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Lab 6-Interfacing of Keypad and Seven Segment Display

Aim: To study the Interfacing of Keypad and 2 Seven Segment Displays on a ‘PIC18F/16F Development Board’
which has on-board Keypad, 2 Seven Segment Displays and 1 L293D IC/16 pin DIP IC slot.

RBE
ReS
R4
REBZ " ktsplosy] -
REz " e
RA1
RBO " vl
f -
PORT D
RD7 - oz
RDE
RS, o
D4 - |
RD3 . lss02
RDZ
RD1 |

fuas
PORT E
RED
REL
RE2
PORT €23
= Rep
- » o Retye
pid o SR 1] |
W I3
s :’" |:-:1 o
il Y
%
Made In INDIA = LB 2

D& Ta BT SUGNE  pICABF/16F Development Board
Min b - AMOTECH | ARS Pune

smePePr ENRVEYEY 16

arEmrEsECECOE R B R E e EEE ... T
3 ¥

ACCESS GREHMTELD

Procedure:
1.Inthis program, we enter the 4 digit code ‘4201’ after which ‘Access Granted” appears on LCD and a 2 digit
number from 0 to 99 are displayed on 2 Seven Segment Displays after 1 Second delay.
2.Read the Program on next page with all the comments which explains the program.
3.0pen the Project folder for the program in MPLAB X IDE or write it by making new project as per MPLAB X
IDE procedure explained in the manual. Build and generate the Hex file for the same.
4.0pen MPLAB IPE and follow the procedure explained to download the Hex file for the above program.
5.As you vary the PWM signals fed to pin RC2, you will see brightness of LED connected to RC2 changes.

6.Make sure that the arrow side of the programmer must be connected to the RST pin of the ICSP connector of the
board.
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Program:

$include <xc.h> /f Core XCE compiler header

#include <picl3f452.h> ff Device-specific definitions for PICLEF452
#include <string.h> /4 Bequired for string comparison functions

#include <stdio.h>
#include <stdlib.h>

#define XTAL FREQ 20000000

$pragma 0OSC = HS

$pragma LWVP = OFF
$pragma WDT = OFF
$pragma BOR = OFF

LCD pin definitions (4-bit mode)
$define ES LATDbits.LATDO J4 LCD Register Select pin
$define EN LATDbits.LATD1 /f LCD Ena
$define D4 LATDbits.LATDZ S LCD data kit D
$define D5 LATDbits.LATDS S LCD data kit DI
$define D& LATDbits.LATDE S/ LCD data bit D6
$define D7 LATDbits.LATDT S LCD data kit D7

S f EKEeypad column inputs

$define coll PORTBbits.RE3
$define colZ PORTBhits.REBZ
$define col3 PORTBbits.REL
$define col4 PORTBbits.RBO

; FEeypad row inputs
$define rowl PORTBbits.RET
$define rowZ PORTBbits.REE
$define row3 PORTBbits.RBS
$define row4d PORTBbits.REBE4
S { Seven-segment digit ena
$define 5501 PORTDbits.RDZ ff En

$define 5502 PORTDbits.RD3 /f Enable second T-s

ble

iT
]
™

i
1]

Lookup tabkle for common—cathode
unsigned char walue[l0] =

11
OX3F, // ©
oXo06, // 1
0X5B, // 2
OX4F, // 3
oxee, /4
OXeD, // 5
oX7D, // &

oxor, 77507
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OX7TE, /S E
OX&6F ffo8
- 1,
Jr ks Loop wvariabkles for T-segment counting
Function declarations
wvoid LCD Init();
void LCD Command (unsigned char);
void LCD Char(unsigned char x):
void LCD string(const char *);
vold led clear();
F/ Password buffer and index
char pass[4], 1 = 0:
Feypad initialization
void keypad init()
1 {
TRISE = 0OXFO; Ff Upper nibkle input (rows), lower nikbble outp
PORTE = 0X00; /f Clear PORTH
INTCONZbits .EEBFU = 0O; '/ Enable PORTE intermnal pull-ups
-}
Jf LCD initialization segquence
vold LCD Imit()
1 {
LCD Command (0x02) ; J¢ Imitialize LCD in 4-kit mode
LCD Command (0x28) ; Ff 2-line display, Sx7 font
LCD Command (0x0C) ; S/ Display CN, cursor OFF
LECD Command (0=x08) ; "/ Auto-increment Cursor
LCD Command (0x01) ; Clear displa
__delay m=s(2); Command execution delay
-}
J4 Send command to LCD
void LCD Command (unsigned char cmd)
{
RS = 0; S ¢ Select command register
/4 Send upper nikble
04 = (cmd>=>4)& 0x0L1;
D5 = (cmd>>5)& 0x01;
De = [cmd>>8)& O0x0L1;
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D7 = (cmd>>T)& 0x0L1;
EN = 1; delay ms({53}); EH = 0;

D4 = cmd & O0x01;

D5 = (cmd>>1)& Ox01l;
DE = (cmd>>2)& 0x01;
D7 = (cmd>>3)& 0x01;

EN = 1; delay ms({53}); EH = 0;

{

RS = 1:

Upper nibble
04 = (data>>4)& 0x01;
DS = (data>>5)& 0x01;
De = (data>>e)& 0x01;
D7 = (data>>7)& 0x01;

EN = 1; delay ms({5): EN = 0;

4 = data & 0=x01;

DS = (data>»>l) & 0x01;

De idata>>2) & O0x01;

D7 (data>>3) & 0Ox01;

EN = 1; delay ms({5): EN = 0;

R — - Ty

lMsplay String on Li.D

void LCD string(const char *msg)
1 1

while( (*m=sg) = 0)
{
LCD Char (*msg);
msg++;
}
}
Clear LCD display

vold led clear()

|'-||-

__delay ms(50);

__delay ms(50);

m
L]
it
g
(51}
it
fu
I
im

[T}
I
L]
it
m
I

__delay ms(50):

__delay ms(50):
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11
LCD Command (0x01) ; ff Clear display command
__delay ms(3);

int cursor = 182, flag = 0; // Curscor position for LCD
lcd cleax():

LCD string("ENTER UR PASSKEEY");

LCD Command (0xC0) ; /f Mowve cursor to second line
i=a0:;

while (i < 4) /f Read 4 key presses

{

flag = cursor;

m

Column 1 actiw
coll=0; colZz=col3=cold=l;
if(!rowl){ LCD Char('l"'):; pass[i++]='l': cursor++; while(!rowl): }
else if(lrowl){ LCD Char('<2"); pass[i++]="4"; cursor++; while(!row2):
elzge if(lrow3){ LCD Char('7"): pass[i++]="7"; cursor++; while (!row3):
else if('rowd){ LCD Char('*"): pass[i++]="*'; cursor++; while(!rowd): }

g

fF Column 2 actiw
col2=0; coll=col3=cold=1;

if('rowl){ LCD Chaxr('2'); pass[i++]='2"; cursor++; while('rowl); 1}
else if(!row2){ LCD Char('5"); pass[i++]='5"; cursor++; while (!rowi);
else if('row3){ LCD Char('3"):; pass[i++]="2'; cursor++; while (!row3):
else if(!row4d){ LCD Char('0"): pass[i++]="0"; cursor++; while(!rowd): }

m

bt

! Column 2 actiw
col2=0; coll=col3i=cold=1;

if('rowl){ LCD Char('2'"); pass[i++]="2"'; cursor++; while(lrowl): }

elge if(!lrow2){ LCD Char('5'): pass[i++]='5"; cursor++; while(!row2); }

im

else if(!row3){ LCD Char('2'): pass[i++]='2"; cursor++; while(!'row3); }
eglge if(!rowd){ LCD Char('0'): pass[i++]='0"; cursor++; while (!rowd); }
Column 3 active

col3=0; coll=colZ=cold4=1;

if('rowl){ LCD Char('3"); pass[i++]="3';: cursor++; while(l!rowl): }

elge if(!lrow2){ LCD Char('c'): pass[i++]='c"; cursor++; while(!rowl); }

else if(!row3){ LCD Char('2"); pass[i++]='%2"; cursor++; while(!'row3); }

else if(lrowd) { LCD_ChaI:'#'}; pass[i++]="#"; cursor++; while(!rowd); }
Column 4 actiwv

cold=0; coll=colZ=col3=1;

if('rowl){ LCD Char('A"); pass[i++]="R'; cursor++; while(l!rowl): }

elge if(!row2){ LCD Char('E'): pass[i++]='E'; cursor++; while(!row2); }

else if(!row3){ LCD Char('C'): pass[i++]='C"; cursor++; while(!'row3); }

elge if(!rowd){ LCD Char('D'): pass[i++]='D"; cursor++; while (!rowd); }

im
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f Mask typed character with
if{i > 0)
{
if(flag '= cursor)
__delay ms(100);
LCD Command (cursor — 1):
LCD Char('*'});

f Password accepted messag

m

vold accept()

1 ¢
lcd clear():
LCD string ("WELCOME") ;
LCD Command (192):
LCD string("Password accept"):
__delay ms=(200);
T

P

Wrong password message

wold wrongil)

{
lod clear():
LCD string("Wrong passkev"):
LCD Command (152);
LCD string("Flz try again!"};:
__delay ms(200);

}

f/ Main program

wold maini)

{
INTCON = 0X00; /f Disable all interrupts
TRISD = 0X00; /4 PORTD as output (LCD + S55D)
LCD Init(}): S Imitialize LCD

LCD string ("ELECTRONIC CODE"):
LCD Command (0xCO) ;

LCD string("LOCE SYSTEM"):
__delay m=(2000);

lcd clear():
LCD string("BY ANITI!"):
__delay ms({2000):

while (1)
i
i=0;
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keypad init(): S/ Imitialize keypad
keypad(): S BRead password

—
L

m

i heck entered passworc
if (strncmp (pass, "4201",4) == Q)
{
accept ()7
lcd clear():
LCD string ("ACCESS GRANTED"):
__delay m=(300);

TRISE = 0X00; S/ PORTB as output (7-segment)
INTCOH2bitcs.REFT = 1;

while (1)
{
55D1 = 1; 55Dz = 1;

for (i=0;i<10;i++4)

{
for(j=0;3<10:j++)
{
for(k=0;k<100: k++)
{
55D1 = 0; 55D2 = 1;
FPORTE = wvalue[i]:
__delay ms(3});:
55D1 = 1; 5502 = 0;
FORTE = walue[]j]:
_delay ms(3}):
}
}
}
}
}
else
{
lcd clear ():
LCD string("ACCESS DENIED"
wrongi():
__delay ms(300);
}
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Lab 7-Interfacing of 12C LCD Display

Aim: To study and implement the interfacing of a 16x2 LCD module using the [2C communication protocol
with a PIC18F/PIC16F micrnocontroller developmet board.

Procedure:

« Connect the I2C LCD (SDA, SCL, VCC, GND) to the PIC development board.

« Read the program with comments to understand I2C initialization and LCD functions.

« Open the project in MPLAB X IDE (or create new), build and generate the Hex file.

» Load the Hex file in MPLAB IPE and program the microcontroller.

« Power ON the board and verify that the text appears on the [2C LCD.

« Ensure the programmer’s arrow side is connected towards the RST pin of the ICSP header.
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Program:
#include <xc.h>

#pragma config OSC = HS [/ Oscillator Selection |
#pragma config WDT = OFF // Watchdog Timer (Disabled
$fpragma config PWRT = ON // Power-up Timer (E
#pragma config BOR = ON // Brown-out Reset (Enabled
#pragma config LVP = OFF // Low Voltage ICSP (Disabled

$define XTAL FREQ 20000000 // 20 MH=z
ff ——= ??“ Z'F Settings ---

$define I2C 1LCD ADDR Ox4E f/ Common address (Use 0OxTE if O0x4E fails
#define BACKLIGHT 0x08 // Bit 3 controls backlight

#define ENABLE BIT Ox04 [/ Bi
#define RS_BIT Ox01 // Bit 0 is

i}
o™
o
|
1

f/ —=--- 12C Basic Functions ---

] void I2C Init(void) {

TRISC3I = 1; // S5CL as input
TRISC4 = 1; // SDA as input

SSPSTAT = 0x80; // S5lew rate disabled for 100kH=z

SSPCCON1 = 0x28; f/ Master Mode, Serial Port Enabled
SSPADD = 4%; // 100kHz Ba Rate @ 20MH=z

€] void I2C Wait (void) {
while ((SS5PSTAT & 0x04) || (SS5PCON2 & O0xlF));

] woid I2C_Start (void)
I2C Wait();
SEN = 1;

(] void I2C Stop(void) {
I2C_Wait():
PEN = 1;

AMOTECH Embedded/IoT Development | Automation Services | Training & Counselling
LABS Embedded Development Boards/Kits |[PLC & Automation Training Stations

@E www.amotechlabs.com &) +91-8329537565 % amotechlabs@gmail.com

i ee



AMOTECH LABS
Sharing Enthusiasm for Embedded sttems & Automation.

Ly

void I2C Write (unsigned char data) {
I2C Wait():
SS5PBUF = data;

/i LCD Over I2C Functions
E wvoid LCD Send Byte (unsigned char data, unsigned char rs) {
unsigned char high nibble = (data & 0xFO0) | rs | BACELIGHT;
unsigned char low nibble = ((data << 4) & O0xF0) | rs | BACELIGHT:

I2C Start():
I2C Write(I2C_LCD ADDR):

I2C Write (high nibble | ENABLE BIT); // Pulse High
I2C Write(high nibble): //{ Pulse Low
[/ Send Low Nibble

I2C Write(low nibble | ENABLE BIT); // Pulse High
I2C Write(low_nibble); // Pulse Low

I2C Stop():

void LCD Cmd(unsigned char cmd) |
LCD Send Byte(cmd, 0): // RS = 0 for commands
if (cmd == 0x01) _ delay ms(2); // Clear display needs extra time

[[] void LCD Char (unsigned char data) {
LCD Send Byte(data, R5 BIT); /f RS = 1 for data

[ void LCD Imit(void) {

__delay ms(50); '/ Wait for LCD to power ug
LCD Cmd(0x02); // 4-bit mode initialization
LCD Cmd (0x28) . F/f 2 lines, 5X7 matrix

LCD Cmd (0x0C); // Display ON, Cursor OFF
LCD Cmd (0x08) ; f/ Entry mode

LCD Cmd (0x01); // Clear Display
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void LCD_String[n:onst char* s) {
while(*s) I.CD_Char (*3++) ;

}

[ void main(woid) {

ADCON1 = 0x07; >nfigure all PORTA/PORTE pins as digital
I2C_Init();

LCD_Init():

LCD Cmd (0x80) ; Line 1, Position 1
I.CD_StIing ("I2C LCD Test");

LCD Cmd (0xCO) ; Line 2, Position 1
LCD String("PICl8F452 Ready"):

while(l) {

}
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Lab 8 — Interfacing of RTC (Real Time Clock) Module

Aim: To study and implement the interfacing of a Real Time Clock (RTC) module using the I2C communication
protocol with a PIC18F/PIC16F microcontroller to read and display real-time date and time.

Procedure:

1. Connect the RTC module (SDA, SCL, VCC, GND) to the PIC development board.

2.Read the program to understand [2C communication and time read/write functions.

3.Open or create the project in MPLAB X IDE, build and generate the Hex file.

4.Load the Hex file in MPLAB IPE and program the PIC microcontroller.

5.Power ON the board and verify that the RTC time is displayed on LCD/Serial as programmed.
6.Ensure the programmer’s arrow is aligned towards the RST pin on the ICSP connector.
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Program:

#$include <xc.h>

#include <stdio.h>

fpragma config OSC = HS
$pragma config WDT = OFF
$pragma config LVP = OFF
#pragma config PWRT = ON
fdefine XTAL FREQ 20000000

$§define RS PORTDbits.RDO
§define EN PORTDbits.RD1
#define LCD DATA PORT PORID
f§define RT:_EDDR Oxes

E woid I2C Init(void) {
TRISC3 = 1; TRISC: = 1;
SSPCON]1 = Ox28;
S5PADD = 49;
SSPSTAT = (0x00;
-}
] woid I2C Wait(void) {
while ((SSPCONZ & Ox1F) || (SSPSTAT & 0x04));

= 1

void IEC_ﬁtart{VDid} { IZC_Wait{I: SEN = 1: 1}

void I2C Stop(void) { I2C Waic():; PEN = 1; }

void IZC_Hrits{unsiqned char data) { I2C Wait():; SSPEUF = data; }

[] unsigned char I2C Read(unsigned char ack) f{

unsigned char data;

I12C Wait():; RCEN = 1;

IZC_Wait{}; cdata = S55PEUF;

I2C Wait(); ACKDT = (unsigned char) (ack ? 0 : 1)
ACEEN = 1;

return data;

=
———————————————— IMPROVED LCD F TIONS =
void LCD Strobe (void) {
EN = 1;
__delay us(s); Increased for stability
EN = 0;
__delay us(100): Increased for stability
}
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E woid LCD Write(unsigned char wvalue, int is dacta) {

R5 = (unsigned char) (is _data ? 1 : 0);

LCD DATA PORT = (unsigned char) ((LCD DATA PORT & Ox0F) | (value & O0xFO0));

LCD Strobe():

LCD DATA PORT = (unsigned char) ((LCD_DATA PORT & OxOF) | ((value << 4) & OxF0)):
LCD Strobe():

__delay ms(2):

-}

] void LCD Imit(void) {

TRISD = 0Ox00;

PORTID = 0x00;

__delay ms({100); // Wait for LCD power to stabilize
Force Reset Sequence for 4-bit mode

LCD DATA PORT = 0x30; LCD Strobe(): delay ms(1l0):

LCD DATA PORT = 0x30; LCD Strobe(): _ delay ms(l):

LCD DATA PORT = 0x30; LCD Strobe(); _ delay ms(l):

L:D_DATA_PCRT = (x20: LCD_Strobc(}; '/ Switch to 4-bit mode now

__delay ms(l):

LCD Write(0x28, 0):; // 4-bit, 2 lines, 3xE
LCD Wrice(0x0C, 0):; // Display ON

LCD Write(0x06, 0); // Entry mode
LCD_WIitE(ﬂxOl, 0); // Clear screen

__delay ms(3):

=1

] void LCD Print(char *str) {

while (*str) LCD Wricte((unsigned char) (*str++), 1):

[c] unsigned char BCD_to DEC (unsigned char wval) ({

return (unsigned char) ((val >> 4) * 10 + (val & 0x0F)):
-}

] unsigned char RTC_Read[un.signed char reg) {
unsigned char data;

I2C_Starc():

I2C Write((unsigned char) (RTC ADDR << 1))

I2C _Write (reg):;

I2C Waict(); RSEN = 1; // Repeated Start

I2C Write((unsigned char) ((RTC_ADDR << 1) | 1))
data = I2C Read(0):

I2C Stop():

return data;

_———————— } AR T'XT

[E] void main(void) {

char buf[20]:

unsigned char h, m, 3, hl2;
char *period;

ADCON1 = Ox07;

I2C_Init():

LCD Init():
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while (1) {
s = BCD_to_DEC (RTC_Read (0x00)) ;
m = BCD_to DEC(RTC_Read(0x01)):
h = BCD to DEC(RTC_ Read(0x02) & O0x3F);

if (h >= 12) {
period = "PM";
hl2z = (unsigned char) ((h > 12) ? (h - 12) : 12);

} else {
period = "RAM";
hl2 = (unsigned char) ((h == 0) ? 12 : h):
}
sprintcf (buf, "%02u:%02u:%02u %s", hl2, m, s, period):;
LCD Write (0Ox80, 0): // Eow 1
LCD Print(" Digital Clock "):

LCD Write (0xCO, 0); // Eow 2
LCD Print (buf) ;

delay ms (500):
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Lab 9 — UART Interfacing with Serial Monitor (Putty)
Aim:
To study and implement UART (Universal Asynchronous Receiver/Transmitter) serial communication between a PIC
microcontroller and a PC, and to observe and exchange data using a serial terminal program (Terminal).

e
"
E

¥

Ve
% - :
bt ‘._'=_.‘-l: I .I
E . - AR
¥

. - =T ool
JFARTIAANTEENRY 16 (W "Matsape Seagart
~$12261014550

Procedure:

1.Connect the PIC development board’s UART TX and RX pins (RC6 — RX of USB-serial converter, RC7 «— TX of
USB-serial converter) with a USB-to-Serial converter to the PC and common ground.

2.Read the UART program with comments to understand baud rate setup and transmit/receive routines.

3.0Open or create the project in MPLAB X IDE, build and generate the Hex file.

4.Use MPLAB IPE to download the Hex file to the PIC microcontroller.

5.0pen PuTTY serial terminal software (download link: https://apps.microsoft.com/detail/ XPFNZKSKLBP7RJ?hl=en
IN&gl=IN&ocid=pdpshare) and configure the COM port and baud rate.

6.Power ON the PIC board and observe data sent from PIC on the Terminal; send data from Terminal to PIC as per
program logic.
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PuTTY configuration for serial communication

B® PuTTY Configuration

Category:

= Session
. - Logging
E Terminal
i Keyboard
L Bell
i Fealures
5 Window
i~ Appearance
i Behaviour
L Translation
T: Selection
i Colours
= Connection
i-Data
i Proxy
E-58H
i~ Telnet
i Rlegin
- SUPDUP

About

Help

Options controlling local serial lines

Selecta senal line

Serial line to connectto

Configure the serial line
Speed (baud)
Data bits
Stop bits
Parity

Flow control

COMS

9600

8

1

None v
XOM/XOFF w

Cancel

PuTTY Serial monitor to receive data transmitted by the PIC18F / 16F

EF COMS - PuTTY

g |

Procedure:

« When any key is pressed on the keypad, the PIC18F board sends the character to the serial monitor.

«  When a character is typed in the serial monitor, the PIC18F receives it and displays it on the LCD.
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Program:

#include <xc.h>
#include <stdio.h>

fpragma config OSC = HS, WDT = QFF, LVP = QFF, PWRT = ON
#define XTAL FREQ 20000000

// —-—-—- Hardware Pins (Amotech Schematic) ---

$define RS LATDbits.LATDO

#define EN LATDbits.LATD1

#define LCD DATA LATD

#define Cl1 LATBbits.LATEO
#define C2 LATBbits.LATBl
#define C3 LATBbits.LATEB2
#define C4 LATBbits.LATB3
#define R1 PORTBbits.RE4
#define RZ PORTBbits.RBS
#define R3 PORTBbits.REE
#define R4 PORTBbits.RB7

Prototypes

'CHYPES

volid UART Init(long baud):

void UART Write(char data);

volid LCD Init(void):

void LCD Command (unsigned char cmd);
void LCD Char (unsigned char dat):
char GetKey (void):

UART Functions

[E] void UART Init(long baud) {

TRISCé = 0; TRISC7 = 1;

SPBRG = (unsigned char) ((_XTAL FREQ / (64 * baud)) - 1):
TXSTA = 0x20; RCSTA = 0x90;

-}

= void UART Write(char data) {
while (!TXSTAbits.TRMT) ;

TXREG = data:

-}

f/ -—- LCD Functions ---

[[] void LCD_Command (unsigned char cmd) {
LCD DATA = (unsigned char) ( (LCD DATA & Ox0F) | (cmd & O0xFOQ));
RS = Q0 EN = 1: __delay_as(loj; EN = 0;
LCD DATA = (unsigned char) ((LCD DATA & Ox0F) | (cmd << 4)):
EN = 1; delay us(l0); EN = 0;
__delay ms(2);

- 1
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] void LCD Char(unsigned char dat) {

LCD DATA = (unsigned char) ((LCD DATA & OxOF) | (dat & OxFO0));
RS = 1; EN = 1;  delay us(l0); EN = 0;

LCD DATA = (unsigned char) ((LCD DATA & OxOF) | (dat << 4));
EN = 1; delay us(l10); EN = 0;

delay ms(2);

[c] woid LCD_Init(void) {

TRISD = 0x00;

__delay ms(50);

LCD_Command (0x02); LCD_Command (0x28);

LCD Command (0x0C); LCD_Command (0x01);

LCD_CQmmand(Gxﬂﬁj; // Ensure cursor moves right automatically

--— Non-Blocking Keypad Scan ---

[l char GetRey (void) {

Cl=0; C2=1; C3=1l; C4=1;
if('R1){ while(!'R1l); return "'1'; } if('R2){ while('R2); return '4"'; }
if('E3){ while(!R3); return "7'; } if('R4){ while(!R4); return 'C'; }
C2=0; Cl=1; C3=1; C4=1;
if('El){ while(!El); return '2'; } 1f('E2){ while(!E2); return '5'; }
if('R3){ while('R3); return '8'; } if('R4){ while('R4); return '0'; }
C3=0; Cl=1; C2=1; C4=1;

if ('R1){ while(!R1l): return '3'; } if(!R2){ while(!R2); return 'e¢': }
if(!'R3){ while (!R3); returmn '9"'; } if(!R4){ while(!ER4); return '="; }

Ca=0; Cl=1; C2=1; C3=1;

if(!'R1){ while (!R1l); return '+'; } if(!R2){ while(!R2); return '-"; }
if('R3){ while('R3); return '*'; } if(!'R4){ while('R4); return '/'; }
return 0;

-}

[l woid main(void) {

ADCON1 = 0x07:
INTCON2bits.RBPU = 0;
TRISB = 0xFO;

UART Init (9600):
LCD Init():

LCD Command (0x80); // Start at Line 1
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while (1) {

o e L. o4 1VIE &TT =, [ ——
if (PIRlbits.RCIF) {

char rxData = RCREG;

LCD Char(rxData); // Just print the character

f//f ——— 2. SEND: Keypad to Terminal —--—-
char key = GetKevy():
if(key !'= 0) {
if(key == 'C') {
LCD Command (0x01); // Fress 'C' to clear screen
LCD_Command (0x80) ;
} else {
UART Write (key):
LCD Command (0xCO0) ;
LCD Char('>"):
LCD Char (key):
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Lab 10 — Interfacing of Two DC Motors using L.293D Driver IC

Aim:
To study and implement the interfacing and bidirectional control of two DC motors using the L293D motor driver
IC with a PIC18F/PIC16F microcontroller.

DC Motor —

.

F StoFF

Procedure:

1.Connect Motor-A to OUT1 & OUT2 and Motor-B to OUT3 & OUT4 of L293D.
2.Connect PIC output pins to L293D inputs as:
RCO — IN1 (Motor-A direction)
RC1 — IN2 (Motor-A direction)
RC2 — IN3 (Motor-B direction)
RC3 — IN4 (Motor-B direction)
3.Connect +5V to L293D Vccl, and motor supply voltage (e.g., +6V to +12V) to Vee2 based on motor rating.
4.Connect GND of PIC board and motor supply to L293D GND pins (all grounds common).
5.Read the provided program to understand direction control logic (IN1/IN2 & IN3/IN4).
6.0pen or create the project in MPLAB X IDE, build and generate the Hex file.
7.Load the Hex file into MPLAB IPE and program the PIC microcontroller.
8.Power ON the board and verify forward, reverse, and stop operations of both motors as per program.
9.Ensure the programmer’s arrow aligns with the RST pin of the ICSP connector during programming.
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Program:

#include <xc.h>

#include <picl8f4s

$pragma config OSC = HS, WDT = OFF, LVP = OFF, BOR = OFF
#define XTAL FREQ 200000000L

J ========S=sS====== LCD FUNCTICHS (PORTD) ====s=ss=ssosso===
void LCD Command (unsigned char cmd)
=
LATDbits.LATDO = O; RS = C
LATDbits.LATD1l = 1; // EN = 1
LATD = (LATD & 0x03) | (cmd & OxFO): High nibble on RD2-RDS
__delay ms(2):
LATDbits .LATD1 = O;
__delay ms(2):
LATDbits.LATDl = 1;
LATD = (LATD & 0x03) | ((cmd << 4) & OXFO0):; Low nibble
__delay ms(2):
LATDbits.LATD1l = 0;
=}

void LCD Char (unsigned char data)
Bt
LATDbits .LATDO = 1; // RS = 1
LATDbits.LATDl = 1; // EN = 1

LATD = (LATD & Ox03) | (data & OxFO):;
__delay ms(2);
LATDbits.LATDlL = 0O

LTl

__delay ms(2):

LATDbits.LATDl = 1;

LATD = (LATD & 0x03) | ((data << 4) & OxFO):
__delay ms(2):

LATDbits.LATD]1 = 0O;

void LCD _Inmit()
B ¢
TRISD = 0x00; // Entire PORTD as OUTPUT for LCO
__delay ms(20);

LCD Command (0x02); // 4-bit mode
LCD Command (0x28): // 2 lines, 5x7
LCD Command (0x0C); // Display ON, Cursor OFF

LCD Command (0x06); // Auto increment
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[ LCD Command (0x01) ; lear
}

void LCD String(char *str)

{
T while (*str) LCD_Char['str++];

void LCD Clear()

{
T LCD_Command(OxDlJ:

S ——— ¥ Y TR P L= / S

void Motor Forward()

{
LATCO = 1; LATCl = 0;
LATCZ = 1; LATC3 = 0;

void Motor Back ()

{
LATCO = 0; LATCl = 1;
LATCZ = 0; LATC3 = 1;

void Motor Left()

{
LATCO = 0; LATICLl = 0;
LATCZ2 = 1; LATC3 = 0;
}
void Mntar_Right[}
{
LATCO = 1; LATCL = 0O;
LATC2 = 0; LATC3 = 0;
}

void Motor Stop()
{

LATC = 0Ox00;

—3 —3 @ —m @ —m —

char Keypad Read()
S
INTCON2bits.REBPU = 0; Enable pull-ups
TRISB = Ox0F; f/ RBO-RE3 Input COL) , RBE4-RB7 Output (ROW

LATE = 0blll0l1111;
__jela;_ma[sj:
if('RBO || 'RB1l || 'RB2 || 'RB3) return '"l1';
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LATE = 0bl11011111;
__delay ms({3);
if('RBO || 'RB1 || 'RB2 || 'RB3) return "'2';

LATE = OblO111111;
__de;ay_ms[3};
if(!RBO || 'RB1 || 'RB2 || 'RB3) return '3';

LATB = 0ObO11l1111l;
__delay ms(3);
if('RBO || !'RBl || 'RB2 || !RB3) return '4';

return 0;

void main()

S
TRISC = 0Ox00; // PORTC output for motors
LATC = 0Ox00; // Motors off initially
TRISB = 0x0F; Keypad RBO-RBE3 input
INTCONZ2bics.RBPU = 0; // &nable internal pullups

LCD Inic():

LCD Clear():

LCD String("READY!");
while (1)

{
char key = Keypad Read():

switch (key)
{
case 'l'
Hutcr_Farwnrd[]:
LCD_Clear():
LCD String("Moving
break;

)

N
1]
H
)
~

case '2':
Motor_Back();
LCD_Clenr[]:
LCD_String("Moving Backward");
break;

case "3':
Motor_Left():
LCD_Clea:[];
LCD _String("Turning Left");
break;
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case '4":
Motor_Right():
LCD_Cleax():
LCD String("Turning Right");
break;

default:
Motor_Stop():
LCD Clear():
LCD String("Stopped");:
break;

delay ms(150);
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Lab 11 — Interfacing of Servo Motor

Aim:
To study and implement the interfacing of a servo motor with a PIC18F/PIC16F microcontroller using compare
mode control to rotate the shaft to desired angular positions.

Procedure:

1. Connect the servo motor’s signal pin to a capable pin of the PIC (e.g., RC2/CCP1), VCC to +5V, and GND to
common ground.

2.Read the program to understand CPP configuration and angle control using duty cycle variations.

3.0pen or create the project in MPLAB X IDE, build the code, and generate the Hex file.

4.Use MPLAB IPE to program the PIC microcontroller with the generated Hex file.

5.Power ON the development board and observe the servo rotating to different angles as per the program (e.g., 0°, 90°,
180°).

6. Ensure the programmer’s arrow is aligned towards the RST pin on the ICSP connector during programming.
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Program:

$#include <xc.h>
#include <picl8f452.h>

[/ === CONFIG BITS =—————eeeeeeeeeee
$pragma config OSC = HS, OSCS = OFF

fpragma config PWRT = OFF, BOR = QFF, BORV = 2

$pragma config WDT = OFF, WDTPS = 128

fpragma config STVR = ON, LVP = OFF

#pragma config CPO = OFF, CP1l = OFF, CP2 = OFF, CP3 = OFF

#pragma config CPB = QOFF, CPD = OFF

$pragma config WRTO = OFF, WRT1 = OFF, WRT2 = OFF, WRT3 = OFF
fpragma config WRTC = OFF, WRTB = OFF, WRTD = OFF

#pragma config EBTRO = OFF, EBTR1l = OFF, EBTR2 = OFF, EBTR3 = OFF
#pragma config EBTRB = OFF

$define XTAL FREQ 20000000UL

SERVO TIMING CALCULATIONS JERY IMPORTANT
' CPU Frequency (Fosc) = 20 MH=z
Instruction Clock = Fosc / 4 = 20MHz / 4 = 5 MHz
——=> Instruction Time = 1 / SMHz = 0.2 ps per tick
Timerl Prescaler = 1:1 | sen in T1CON
—-——> Timerl Tick Time = 2 pus
Standard analog servo frequency = 50Hz
===> Period = 1 SOHz = 2s = 20, s (20ms
-—=> Required Timerl ticks for 20ms:
20000us ).2us = 100000 ticks
Pulse widths for position:
1.0ms (1000ns = 1 2= 5 ticks
- 1.5ms (1500us = 15 2 = 75 icks
2.0ms (2000ns) = 2 2 =1 ticks
FRAME TICES = 100000 (fixed for S50H=z
pulse ticks = 5 to 10 depending on position
CCPl Compare mode schedules two events
1) Set RC2 HIGH at start of frame
2 et RC2 LOW after pulse ticks
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#define FRAME TICKS 100000UL S/ 20ms = 20000us / O0.2ps = 100000 ticks
volatile unsigned int pulse ticks = 7500; jefault 1500us = 90°
volatile unsigned char phase = 0; '/ O=start pulse, l=end pulse

void interrupt() isr(void)

if (PIRlbits.CCFPLlIF) // CCPl compare event happened?
{
PIR1bits.CCP1IF = 0; // clear flag
if (phase == 0)
{
5] e
START CF PULSE
PORTICbits.RC2 = 1; irive servo signal HIGH
= schedule pulse end time
B (current time pulse ticks
CCPR1 = pulse_ticks;
phase = 1;
}
else
{
Hi | ] c—————
END OF PULSE
PORTCbits.RC2Z = 0; drive servo signal L
ﬂﬂ schedule star f next 20ms frame
B // (current time + (FRAME TICES pulse ticks
CCPR1 += (FRAME TICES - pulse_ticks):
phase = 0;
}
}
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void Timerl Init(void)

E {
= f/ T1CON bits:

 TICEPS51:T1CEPS0 = 00 --> Prescaler = 1:1
TMRI1CS = 0 -=->» Internal clock (Fosc/4)
TMRION = 1 ==> Enable Timerl
B ff Result: Timerl tick = 0.2us
TI1CCH = 0b00000001; // Prescaler 1:1, internal clock, Timerl ON

CCP1 INIT (COMPARE MODE

void CCP1 Init (void)

E {
- // CCP1lCCN bits:

- f/ 0b0000101l = Compare mode, trigger special event

CCP1CON = 0b00001011;

=] f/ First event after complete frame:

B // CCPR1 = 100000 ticks (20ms)

CCPR1 = FRAME TICKS;

PIR1lbits.CCPlIF = 0; // clear flag
PIElbits.CCP1IE = 1; // enable CCPl interrupt

void main(void)
o«
TRISCbits.TRISC2 = 0; // RC2 as output for servc
PORTCbits.RCZ2 = 0; // start LOW

Timerl Init():
CCP1_Init();

INTCONbits.PEIE = 1; /f enable peripheral interrupts
INTCONbits.GIE = 1; // global interrupt enable

AMOTECH Embedded/IoT Development | Automation Services | Training & Counselling
Embedded Development Boards/Kits |[PLC & Automation Training Stations

I_/\E3SS eﬂmw!! [\ |

& W \\\w.amotechlabs.com ) +91-8329537565 amotechlabs@gmail.com



AMOTECH LABS
Sharing Enthusiasm for Embedded sttems & Automation.

while (1)
{
5 Test swee]
LEFT = ms [ ge = 3§ t 3
CENTER = 1.5ms pulse = 75 ticks
o RIGHT = ms I gE = g
pulse ticks = 5000; '/ 1000ps
_delay ms(1000):
pulse_ticks = 7500; // 1500ms
__delay ms(1000);
pulse_ticks = 10000; // 2000ups
~delay ms(1000):
}
-}
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Lab 12 — Interfacing of Stepper Motor

Aim:
To study and implement the interfacing and step-wise rotational control of a stepper motor using a PIC18F/PIC16F
microcontroller through a suitable driver circuit (e.g., ULN2003/L293D).

ol 17 1| CET) )|

ULN2003A Driver Module
Stepper Motor Driver

- : pami] 4
; b

kit ]

Ind 2 =]

= JooGRE A 1

ds | STM32 Nano boards o

28BYJ-48 Stepper Motor DC 5V — e — -}: A
Used Inside the Box .

'.i-

Procedure:

1. Connect the stepper motor coils to the driver IC (ULN2003) as per the pin sequence (A—-B—C-D).

2.Connect PIC output pins (e.g., RCO-RC3) to the driver input lines to energize the coils in sequence.

3.Connect motor supply voltage to the driver IC Vcc, and connect GND of PIC and driver common.

4.Read the program provided to understand the step sequence (Full-step / Half-step) and delay control.

5.0pen or create the project in MPLAB X IDE, build and generate the Hex file.

6.Load the Hex file into MPLAB IPE and program the PIC microcontroller.

7.Power ON the board and observe the stepper motor rotating in clockwise or counter-clockwise direction based on
coil energizing sequence.

8.Ensure the programmer’s arrow aligns to the RST pin of the ICSP header during programming.
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Program:

$include <xc.h>
#include <picl8f45s

${pragma config OSC = HS, 0SCS = OFF

#pragma config PWRT = OFF, BOR = QOFF, BORV = 2

$pragma config WDT = OFF, WDTPS = 128

$#pragma config STVR = ON, LVP = OFF

$pragma config CPO = OFF, CPl1 = OFF, CP2 = OFF, CP3 = OFF

fpragma config CPB = QFF, CPD = OFF

#pragma config WRTO = OFF, WRT1l = OFF, WRT2 = OFF, WRTI3 = OFF
#pragma config WRTC = OFF, WRTEB = OFF, WRTD = OQOFF

#pragma config EBTRO = OFF, EBTR1 = OFF, EBTR2Z = OFF, EBTR3 = OFF
$pragma config EBTRB = OFF

#define FULL ROTATION STEPS 512
volid MSdelay (unsigned int wval)
{
unsigned int i, 3j:
for(i = 0; 1 < wval; 1i++)
for(j = 0; § < 165; j++):

void Stepper Clockwise (int period)

[
for(int i = 0; i < FULL ROTATION STEPS:; i++)
{
LATD = 0x09; MS5delay(period):; // 1001
LATD = 0x08; MSdelay(period); // 100C
LATD = 0x0C; MSdelay(period):; // 110C
LATD = 0x04; MS5Sdelay(period).,; // 010C
LATD = 0x06; MSdelay(period): // 011C
LATD = 0x02; MSdelay(period):; // 001C
LATD = 0x03; MSdelay(period); // 0011
LATD = 0x01; MSdelay(period); // 0001
}
e
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volid Stepper_ Anticlockwise (int periocod)

(=
for(int i = 0; i < FULL_ROTATION_STEPS; i++)
{
LATD = 0x0l; MSdelay(period);
LATD = 0x03; MSdelay(period); // 0011
LATD = 0x02; MSdelay(period);
LATD = 0x06; MSdelay(period); // 011C
LATD = 0x04; MSdelay(period);
LATD = 0x0C; MSdelay(period); // 110C
LATD = 0x08; MSdelay(period):
LATD = 0x09; MSdelay(period): // 1001
}
-}

void main(void)
Bt
int period = 5; // smaller = faster rotation
TRISD = 0x00; '/ Make PORTD outputs
LATD = 0x00; // Initialize outputs off

while(l)
{

- - -] 1~ as

Stepper Clockwise (period):
MSdelay(1000) ;

S S— - a A5 ol Smmna s
LaLE 0L ANC1ICLOCKWL

Stepper_Anticlockwise (period);
MSdelay(1000);
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Lab 13 — Interfacing of Relays using UDB

Aim:
To study and implement relay control using a PIC18F/PIC16F microcontroller, where pressing SW1 turns ON Relay 1

and pressing SW2 turns ON Relay 2 through a relay driver interface.

. -
e e
——

. YO L | LY N

Sesassssassssss
A A X L E R

Je r_j @ II.;_ 1

l.—
K

-/

= =

swl & sw2

Procedure:
1.Connect SW1 and SW2 to UDB of D11 &D10 and connect Relay 1 and Relay 2 to A0 & Al.
2.Connect the UDB relay driver board to the PIC.
3.Read the relay control program which assigns SW1 — Relay 1 ON and SW2 — Relay 2 ON.
4.0Open or create the project in MPLAB X IDE, build the code, and generate the Hex file.

5.0pen MPLAB IPE, load the Hex file, and program the PIC microcontroller.
6.Power ON the system and verify: pressing SW1 turns Relay 1 ON and pressing SW2 turns Relay 2 ON.
7.Ensure the programmer’s arrow is aligned towards the RST pin on the ICSP connector during programming.
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Program:

#include

R ':H_

_XTAL FREQ 20000000

#define
#pragma config OSC = HS, WDT = OFF,
LCD pins

#define LCD RS LATDbits.LAIDO
#define LCD EN LATDbits.LATD1
#define LCD D4 LATDbits.LAID4
fdefine ;CD_DS LATDbits.LATDS
#define LCD D& LATDbits.LARIDG
fdefine ;CD_DT LATDbits.LATD7

LVP = OFF,

DEBUG = OFF,

PWRT = ON, BOR = OFF

void LCD Imit(void):
void LCD Cmd(unsigned char cmd):
void LCD Char (char data):
void LCD String(const char *txt):
void LCD Clear(void):
void LCD Goto(unsigned char r, unsigned char c);
volid ShowModes (void) :
vold main(void)
(S
TRISCbits.TRISCS = 1; SW1
TRISAkits.TRISA4 = 1; SW2
TRISAbits.TRISAD = 0; elayl
TRISAbits.TRISAL = 0; Relay2
LATAbits.LATAOD = 0;
LATAbits.LATAL = 0;
LCD port
TRISD = 0x00;
Digital mode
ADCON1 = 0x0F;
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o= ey =T TR

LCD Init():
LCD Clearx():

LCD Goto(l,1); LCD String("PIC Dey Boaxd");
LCD Goto(2,1); LCD String("With UDB");

__delay ms (1500):;
2) SHCOW MODES

ShowModes () ;

while (1)
{

" MODE 1 — Relayl

if (PORTCbits.RC5 == 0) {
LCD Clearx():
LCD _String("Relayl ON");
LATAbits.LATAO = 1;
while (PORTCbits.RC5 = 0); // wait release
LATARits.LATAC = 0O;
ShowModes () ;

f/f MODE 2 — RelayZ

if (PORTAbits.RA4 == 0) {
LCD Clear():
LCD String("RelayZ ON"):

LATAbits.LATAL = 1;
while (PORTAbits.RR4 = 0); // wait release
LATAbits.LATAL = 0;

ShowModes () ;

- 1

void LCD Enable() {
LCD EN = 1; delay us(l0):
LCD EN = 0; _ delay us(l0):

void LCD Cmd(unsigned char cmd)

G
LCD RS = 0;
LCD D4 = (cmd >> 4) & 1;
LCD D5 = (cmd >> 5) & 1;
LCD De = (cmd >> &) & 1;
LCD D7 = (cmd >> 7) & 1;

LCD_Enable();
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LCD D4 = cmd & 1;

LCD D5 fcmd >> 1) & 1;
LCD D6 = (cmd >> 2) & 1;
LCD D7 = (cmd >> 3) & 1;
LCD _Enable():

void LCD Char(char data)

(I
LCD RS = 1;
LCD D4 = (data >> 4) & 1;
LCD D5 = (data >> 5) & 1;
LCD D6 = (data >> €) & 1;
LCD D7 = (data >> 7) & 1;

LCD _Enable():

LCD D4 = data & 1;

LCD D5 = (data >> 1) & 1;
LCD De = (data >> 2) & 1;
LCD D7 = (data >> 3) & 1;

LCD Enable():

void LCD String(const char *txt)

{
[f while(*txt) LCD Char (*txt++);
}

void LCD Init()
[
LCD_RS = 0; LCD EN = 0;
delay ms(20);

LCD_Cmd (0x02) ;
LCD Cmd (0x28);
LCD Cmd (0x0C) ;
LCD Cmd (0x08) ;
LCD Cmd (0x01) ;
__delay ms(2):

void LCD Clear()

{
LCD Cmd (0x01):
__delay ms(2);

void LCD Goto (unsigned char r, unsigned char c)

{
i] if(r = 1) 1LCD Cmd (0x80 + (c - 1)):
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[ else LCD Cmd (0xCO + (c - 1)):
}

void ShowModes (void)

{
LCD Clear():
LCD Goto(l,1); LCD String("SW1l = Eelayl"):
LCD Goto(2,1); LCD String("SW2 = Rel
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‘PIC18F/16F Development Board’ mounted on ‘Universal Development Board’

Video Description [®] % n'. =
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Description:

This setup shows a PIC18F/16F Development Board mounted on a Universal Development Board (UDB) inside a
wooden enclosure. The kit is fitted on an Acrylic Sheet along with peripherals like DC Motor, Stepper Motor, Servo
Motor, Keypad, LCD, 7-Segment Display, and Relay Modules.

It also supports expansion peripherals such as GSM Module, RTC Module, SD Card Module, and UART/Serial
Communication, enabling a wide range of embedded interfacing studies using PIC microcontrollers.
This hardware was assembled for college laboratory use to help students practically understand motor control, display
interfaces, RTC & SD logging, GSM communication, relay switching, and sensor integration with PIC18 MCUs.
For students and hobby projects, the UDB is also available separately along with a Embedded Systems Training
& Education like-
/ College Lab Experiments / Practicals
/ Mini & Major Project Development
«/ Product Prototyping & Testing
/ Motor Control & Automation Projects
/ RTC + SD Card Data Logging Projects
+/ Remote Monitoring using GSM Communication
«/ Sensor Interfacing & Real-Time Control
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